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Introduction

This manual provides instructions for the the LS450 ConfigTool 2.0 software that is used to program vari-
ous Tek-CARE systems. 
The LS450 ConfigTool 2.0 is designed to run on the technician's programming laptop. The programming 
laptop and the Tek-CARE system being programmed are networked together using a standard network 
patch cable between the Tek-CARE Network ports on various modules.
Master stations, TVs, mobile devices, etc. will display any changes made to the system that were created 
and/or modified in the LS450 ConfigTool 2.0 software. Make sure to have all of the appropriate manuals 
accessible when preparing modules, master stations, servers, and systems for installation.
 

Installing the Software on a New System
NOTE: The LS450 ConfigTool 2.0 and Tek-CARE system must be running the same ver-
sion of software, so that the LS450 ConfigTool 2.0 can commit a configuration to the Tek- 
CARE system. A newer LS450 ConfigTool 2.0 can load a configuration from an older sys-
tem and can update the Tek-CARE system to the newer version.

Regularly obtain the latest LS450 ConfigTool 2.0, and use it to update the Tek-CARE 
system.

A laptop running Windows is used to run the LS450 ConfigTool 2.0. The Tek-CARE system includes an 
LS450 ConfigTool 2.0 Programming Software USB flash drive. Insert the flash drive into a USB port of 
the computer to be used for programming the configuration. View the USB flash drive's contents using Win-
dows Explorer, and double-click on LS450_setup_xxxx.exe (where xxxx is the software version). Follow 
the prompts to install the software. Remove the USB flash drive when the install is complete.
 

Network Setup
In order to communicate with the Tek-CARE Network, the programming computer running the LS450 Con-
figTool 2.0 must have one Ethernet port configured to communicate with the Tek-CARE Network. 
Access the network connections settings in Windows 10 by selecting Start→Control Panel→Network 
and Internet→View Network Status and Tasks.
Access the network connections settings in Windows 11 by selecting Start→Control Panel→Network 
and Sharing Center→Change Adapter Settings.
Select Ethernet Connections, then Properties. Select Internet Protocol Version 4 (TCP/IPv4), then 
Properties. Check Use the following IP address and enter the following:
Tek-CARE IP address: 192.168.1.252 | Subnet Mask: 255.255.255.0
Select OK and close out of the Ethernet Properties.
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Introduction

Running the LS450 ConfigTool 2.0 Software
Running the LS450 ConfigTool 2.0 with an existing configuration already on the system: 

 1.  Open the LS450 ConfigTool 2.0 on the programming laptop that is connected to the Tek-
CARE Network to start the LS450 ConfigTool 2.0 Software. 

 2.  In the Tek-CARE ConfigTool 2.0 splash screen, select the IP Address of the network interface that 
is connected to the Tek-CARE Network (normally 192.168.1.252).

 3.  Select Load Configuration from System. If patients have been added in the configuration, the soft-
ware will prompt to either Load with Private Data, Load without Private Data (this option will 
change the names of the patients), or Cancel Loading (this option will return the user to the splash 
page).
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Work Flow
The LS450 ConfigTool 2.0 supports several methods of importing data, and may be used in different ways 
depending upon circumstances. Be sure to save the configuration often.
Below is a general example of the work flow for configuring a new system:

 1.  Install the hardware and check all wiring for shorts, grounds, and opens.
 2. Open LS450 ConfigTool 2.0 and select Load Configuration from System.
 3.  Review the detected Modules on the System page within the software and add modules if neces-

sary. If the modules are missing from the configuration, double check the DIP switch addressing or 
correct the connections (Modules Tab on page 17).

 4.  Select the Masters tab on the Annunciation page to ensure all of the masters have been detected 
and are included in the configuration (Masters Tab on page 36). Rename if necessary.

 5.  Select the Stations tab on the Field Devices page to ensure all of the stations have been detected 
and included in the configuration (Stations Tab on page 28). Rename as necessary.

 6.  Set up zone names with the Zones tab on the Annunciation page, then  place the stations and mas-
ters within those zones (Zones Tab on page 34).

 7.  Set up annunciations for duty stations and zone dome lights with the Field Annunciations tab on 
the Annunciation page (Field Annunciations Tab on page 35).

 8.  If applicable, edit room controller points for TC120, TC400P5+, TC400GEN3, and TC3000 with 
the Points Tab on the Field Devices page. Be sure to Disable Undetected Points before editing 
room controller points. Refer to (Points Tab on page 29).

 9.  Locations may already be added into the configuration (Locations Page on page 40). Use the Loca-
tions tab on the Locations page to edit or add new locations if necessary. 

 10.  If necessary, select the Paging tab on the Staff Devices page to enable the paging feature (Pagers 
Tab on page 47). 

 11.  Add staff members and staff groups; create and define assignments for each staff member or group 
(Staff Page on page 55).

 12.  Select File→Save Configuration to save changes and File→Consistency Check to find and cor-
rect any issues. Select File→Commit Configuration To System to upload the configuration to the 
Tek-CARE Network. Once the upload is complete, the system will reboot. 

 13.  Test the system before releasing it to the facility.
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Using the ConfigTool 2.0 Programming Software

The System Configuration resides on the Tek-CARE system. Any changes made to the configuration using 
the ConfigTool must be committed to the system to take effect.
Pay close attention to the icons in the lower left corner of the ConfigTool screen. These icons will indicate 
when configurations are synced to the system, where the configuration is stored, if the configuration has 
had a consistency check, and if the NC475 Tek-CARE Central Equipment is maintaining a connection to 
the Tek-CARE Network.

 
System Data Icon - Indicates whether the configuration stored with the LS450 ConfigTool 2.0 is the same 
as the nurse call system's configuration data. The icon will indicate that the data is the same if no changes 
have been made since the initial load or since the last Commit Configuration To System.

Indicates the LS450 ConfigTool 2.0 data is the same as the configuration currently on the Tek-CARE 
system.
Indicates the configuration open in the ConfigTool is different than what is currently on the system.
 

File Status Icon - Indicates whether the current LS450 ConfigTool 2.0 data has been saved.

Indicates the config file has been saved to the hard drive of the laptop running the ConfigTool since 
the last edit.
Indicates the config file hasn't been saved to the local hard drive since the last edit.

 
Consistency Check Icon - Indicates whether the configuration has gone through a consistency check.

The configuration has successfully gone through a consistency check.

The configuration needs to go through a consistency check before being committed to the system.

 
Network Selection Icon - Indicates the network selection that was made when starting the LS450 Con-
figTool 2.0.

One of the active network connections on this machine was selected.

The ConfigTool is being used offline to edit configuration files only.

 
During system programming, remember that the ConfigTool and the Tek-CARE system operate inde-
pendently of each other. If a configuration is created or changed using the ConfigTool, it must be loaded 
onto the system by choosing File→Commit Configuration to System.
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Using the ConfigTool 2.0 Programming Software

When programming the Tek-CARE system, the user must be familiar with the different buttons used to 
interact with the Tek-CARE software.
These buttons appear at the top of editing panes within the ConfigTool:
 

Edit: Before information in an editing pane may be changed, select this  button to unlock the pane 
for editing.
Edit Multiple: Before information in an editing pane may be changed, select this  button to unlock 
the pane for editing.
Apply: Select this button to confirm  programming changes. After selecting this button, the field 
being edited will be locked.

NOTE: This does NOT save the configuration to disk.
Cancel: Select Cancel to undo any programming changes made in the editing pane and lock the 
pane.
Add: Used to add patients, transmitters, pagers, and other items to the configuration. 

Delete: Used to delete records, transmitters, patients, and many other items from the configuration. 

Add Multiple: Used to add multiple records to the Tek-CARE system at once. This is especially 
useful for adding RF pagers with consecutive CAP codes to the configuration.

Delete Multiple: Used to delete multiple records from the configuration at once.

Add Barcode: Used with hand scanner to enter a device # by scanning the back of the unit.

Mark Undetected TC570 Repeaters Not In Use: Marks undetected TC570 Repeaters (NC571) 
"not in use".

 
Input Controls - The Input Controls provide all the basic editing for each component. First, select Add or 
Edit. Next, use the various controls, each of which performs specific functions, to customize each com-
ponent. Select Apply to accept the changes.

 
Drop-Down Lists allow various settings to be selected. The options are fixed; drop-down 
lists do not allow user input.
Check Boxes control On/Off options for components.
Text Boxes are used to enter text, such as a component name.
Spinner Boxes are used for numeric inputs. They have a predetermined range of values for 
each specific field.
Sliders are another type of numeric control with a fixed range. A slider visually displays the 
predetermined range of values as well as the current setting.
Audio Track Selectors are combination control/preview controls that allow the available 
tones to be selected and then played using the selected interval separation.
Check Tables provide a way to select multiple On/Off options at once. Each box represents 
one possible selection for the current component.
Dome Test Bars are used to preview the dome annunciation for a call type. Click Playato 
preview the current settings.
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Station Inputs are used to configure station behaviors.
Status Bar Iconsgat the bottom left of the screen show the programs current configuration.
Tool Tips are available in many places in the LS450 ConfigTool. Each tool tip provides 
information relevant to that option or setting in the software or configuration when hovering 
over certain fields.
Progress Bar at the bottom of the screen displays the percent complete for various pro-
cesses. It also includes a brief description of the current process or step in the process.
Status Text at the bottom  of the screen displays either a brief description of the current pro-
cess or step in the process, or "Ready" if the software is idle.
 

Acknowledgments
FXRuby: This software uses FXRuby (Libraries\FXRuby), a library copyright © Lyle Johnson and covered 
by the GNU Lesser General Public License, and includes code from the Mondrian Ruby IDE, copyright © 
Oliver Smith and covered by the MIT License. 
FatCow Free Web Icons: Many of the icons used in this software are from, or are derived from, those made 
available under the Creative Commons Attribution 3.0 License by FatCow Web Hosting at 
www.fatcow.com/free-icons.
 
Menu Bar
In addition to the areas shown on the home screen, note the menu bar at the top of the window that contains 
the options File, Tools, Utilities, and Help. These menus are described on the following pages.
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File
Under the File menu, note the configuration options.

 o New Default Configuration - Clears all data and reverts to the initial values for all components. 
This is a blank configuration without any existing hardware.

 o New Default Configuration with NC475 - Cleans all data and reverts to the initial values for all 
components, then loads existing hardware types from the system and adds them to the default con-
figuration.

 o Default Configuration with Detected Hardware - Cleans all data and reverts to the initial values 
for all components, then loads existing hardware types from the system and adds them to the default 
configuration.

 o New Configuration From Template - Clears all data and reverts to the initial values for all com-
ponents, then loads a new configuration from selected templates.

 o Open Configuration -  Will load a configuration data  file that has already been created and saved.
 o Reload Current Configuration File - Reloads the configuration data from the most recent saved 

point of the configuration, discarding any unsaved changes.
 o Load Configuration from System - Will load the current system configuration to the program for 

further editing.
 o Sync Configuration with Detected Modules - Synchronizes the current configuration settings with 

actual hardware types present on the system. Most configuration options remain the same; just the 
existence and types of modules, masters, stations, and peripherals are updated.

 o Consistency Check - Checks the configuration in the ConfigTool for compatibility and errors. 
 o Export for Prior Version - Allows the current configuration to be exported to a prior version of the 

software. 
 o Save Configuration and Save Configuration As - Allows to save the current configuration to the 

hard drive of the laptop being used for programming. Throughout the programming process, save 
the configuration regularly. Once programming is complete, save the configuration as a backup. 
This option will overwrite a file generated by an older version and will not be compatible with an 
older version of the software. Make sure to create a backup before installing updates.

 o Commit Configuration to System - Sends the current configuration to the live Tek-CARE Net-
work. If this command has not already been performed, the consistency check will run automatically 
before allowing the configuration to commit.

 o Quit - Exits the LS450 ConfigTool.
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Tools
The Tools menu includes a number of options used for different TekTone systems and integrations:

 o Central Monitoring Device List - Create a printable list that links central monitoring device IDs to 
transmitter IDs, locations, and patient names. This list can be sent to the central monitoring facility 
to aid in identifying the source of a monitored alarm.

 o Callback List - Choose the different options  in the Callback List to Include Masters, Include 
Devices Not Currently In Use, and Include Zone.

 o Move Station Port - If a port needs to be moved to a different port on a different module, select the 
source and destination from one module to another acceptable module that will work with those sta-
tions.

 o Merge NC400 Hardware into NC500 Configuration - Import Tek-CARE400 hardware and sta-
tion names from another configuration file into the currently loaded Tek-CARE500 configuration. 
This option can be used to integrate previously separate Tek-CARE400 and Tek-CARE500 systems.

 o NC300II Database Import to NC356CE - When Tek-CARE400  NC356CE head-end modules will 
be used to replace the central equipment of a TC300II system, this procedure can be used to import 
the TC300II stations database into the Tek-CARE400 System.

 o NC300II Database Import as Foreign Devices - TC300II Stations can be imported as Foreign 
Devices. This option is used when monitoring an TC300II with the NC475 Tek-CARE Central 
Equipment via Tek-ALERT. A valid TC300II database file is required for the import. Repeat for 
each stations.db file to be imported.

 o Import Foreign Devices from File - Import a list of foreign devices from a CSV or tab-separated 
file.

 o Import Foreign Device Rules - Import one or more foreign device rule sets from a saved file.
 o Update Foreign Device Rules - Update one or more foreign device rule sets from a saved file.
 o Export Foreign Device Rules to New File - Export one or more foreign device rule sets to a new 

config file.
 o Export Foreign Device List - Export list of foreign devices to a new config file.
 o Import Location Survey Data - Once a survey is taken for the Enhanced Location, select this 

option to import the data into the software.
 o Clear Location Survey Data - This option will delete an imported survey that is used for Enhanced 

Location.
 o Replace ES Repeater - This option will allow an old repeater to be replaced with a new repeater so 

a new survey doesn't have to be taken.
 o Remove Private Data - This option allows all private patient data such as medications, conditions, 

etc., to be stripped from the configuration so that it can be sent to TekTone for troubleshooting help 
without revealing private patient information. 

 o Restore Private Data - This feature will restore private data if it has been stripped from the con-
figuration. This option will redirect to the saved configuration file. This will prompt to load the file 
with private data onto the system.

 o Import Location Names from File - This option will allow location names to be imported into the 
ConfigTool from a text file.

 o Generate Label Images - This option is used to create custom call type inserts for SF123/SF523 
stations if custom call types are used in the system configuration. 

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1150 LS450 ConfigTool 2.0 Manual | 14

Using the ConfigTool 2.0 Programming Software



Using the ConfigTool 2.0 Programming Software

Utilities
The Utilities menu gives several options. 

 o Reset Modules - This option resets the system hardware immediately without changing the con-
figuration. 

 o Set Time on System - By default, the LS450 ConfigTool uses the Windows system clock time from 
the machine it is running on. This option will change the time independently of the automatic time 
feature on the running system.

 o NC475/NC435G3/NC331 Update Server) - This option will upgrade NC475 Tek-CARE Central 
Equipment and NC435G3/NC331 Hubs. 

 o Upgrade GEN2 Modules (NC120/NC160/NC455CE/NC356CE) - This option upgrades the applic-
able modules to the current software version.

 o NC475 License Update - If you contact TekTone's Sales department and upgrade the license for 
additional features in the ConfigTool, this option will update the NC475's license file for additional 
features in the ConfigTool.

 o Change Subnet on Modules - The facility LAN and Tek-CARE Network cannot be on the same 
subnet. This option will allow for a different subnet to be assigned to the Tek-CARE Network if 
192.168.1.XXX is already used by the facility LAN.

 o Set NC455CE Audio Mode - GEN3 or P5 (legacy) audio modes are assigned here. If an NC455CE 
will be supporting GEN3 equipment, the audio mode would then be assigned as such.

 o ES Location Survey Tool - This tool creates a file of the recorded enhanced location and survey 
points.             

 o TC570 Location Survey Tool - This tool creates a file of the recorded enhanced location and sur-
vey points.             

 o Setup EchoStream Messaging Mode - This feature detects repeaters and programs the Network ID 
for Enhanced Location functionality.

 o Mobile App Echo Test Server - The Mobile App Echo Test is used to determine if the facility's 
wireless network can support the audio functionality of the Staff App.

 

Help
The Help menu displays options related to system information, troubleshooting, and software updates. The 
programming laptop must have a PDF viewer in order to view the Fault Table and Change List.

 o The Fault Table shows a list of all available faults on the system along with a brief description of 
each fault. 

 o The Change List shows what changes have been made to the Tek-CARE software suite since the 
last code release. 

 o About will provide information about the currently installed software.
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System Page

System Info Tab
The System Info tab is used specifically for TekTone's cloud services. 

Select Edit on the System Info tab to enter the system settings. Create a System Name to easily identify 
the configuration. When the cloud system has been set up for the facility, TekTone will supply the System 
ID and Cloud Access Token; enter these values into the appropriate fields, then select Apply.
 

Server Settings Tab
The Server Settings tab allows for the option to automatically backup configurations and reporting, as well 
as automatically exporting backups and sync reporting. Check all applicable options for the facility's needs. 
Select Apply and save the configuration. Uncheck a setting if the facility no longer wishes to use that 
server setting.
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Modules Tab
Modules and Hubs are the backbone of the Tek-CARE system. Once either New Default Configuration 
with Detected Modules or Sync Configuration with Detected Modules have been selected from the File 
menu, the ConfigTool will detect the modules on the Tek-CARE system. To find the detected modules in 
the ConfigTool, select the Modules tab within the System page. 

In the Modules pane, select the module address, then select Edit in the Details pane. Change the type of 
module and enter a location for the module. Detected masters and stations that are connected to that module 
are located in the Attached Devices pane.
Select Apply after editing the Module tab. Select Hide Unused to show only the modules that exist and 
hide the rest of the modules that are not used.
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Modules Port Settings
Use the Modules Port Settings Tab to select the function of each of the four ports on the hub; the choices 
are Station, Master, or Disabled. The default is Station for all four ports. These fields only populate for 
NC435G3 and NC331 hubs.

 
 

Passwords Tab
Password protection is useful to prevent unauthorized facility staff from making changes to the  con-
figuration of the Tek-CARE system, for example: adding or removing transmitters, changing staff assign-
ments, or altering reporting settings. Several different passwords may be used, each protecting different 
system settings. 
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To add a new password, select the Passwords tab, then select Add. In the Details pane, create a password. 
The password can be up to 16 characters. 
The blank entry that exists by default does not require a password to access the various features. If a pass-
word is created, the selected features must be removed from the blank entry. Check the boxes of each fea-
ture that the facility would like password protected. Select Apply and save the configuration. 
To delete a password, select the password, then select Delete.
 

Serial Ports Tab
A serial port is used for paging, various interfaces, and to communicate between a foreign device and the 
Tek-CARE Network. The Serial Ports tab on the System page is used to modify an existing port or to cre-
ate a virtual serial port through use of an IP/Serial converter (CT601, CT701A).

By default, there are six standard serial ports included in the Serial Ports pane (1: NC510ES or NC510UL, 
2: NC570 Receiver, 3: NC365B Paging Transmitter, 4: NC510FA Receiver, 5: Unused, 6: Central Mon-
itoring). To add an additional Serial Port, select the Serial Ports tab, then select Add. 
Enter the Serial Port Number, choose the Type of serial port, enter the IP Address for the IP/Serial Con-
verter, and choose the TCP Port for the IP/Serial converter. Select Apply. 
To delete a serial port, select the serial port, then select Delete.
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Interfaces Tab
The main function of an interface is to provide a way to import events, messages, and data from foreign 
devices and display them on the Tek-CARE system. The interface will specify the port, protocol, and 
options used to read messages from a foreign system.

To create a new interface, select the Interfaces tab on the System page, then select Add. In the Details 
pane, select the appropriate data stream in the Protocol drop-down, then enter the Port number associated 
with the data stream.
Enter the correct Options for each protocol including: Baud Rate, Byte Size, Parity, and Stop Bits. If 
applicable, check the boxes for Xon Xoff, Enable RTS/CTS,  Enable DSR/DTR, and set the desired value 
for Line History Length.
Choose the Rule Set used for the interface. The rule set will determine which rules run for each message 
received on the interface, as well as which hardware behaviors are available to assign to foreign devices on 
the interface. Select Apply. 
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Behavior Page

The Behavior page is used to modify or add station-specific behaviors, call/fault types and filters, and for-
eign rule sets. For example, an SF520UL can have the behavior of a Security Device or a Check In 
Device.
 

Call Types Tab
The Call Types tab is used to create custom call types, and change the various defaults (such as 
LED settings, call definition, dome light settings, etc.).

To create a new call type, select Add in the Call Types pane. 
In the Details pane, select the Call Filters button in the On apply add all call type to... pane, then check 
the appropriate boxes to apply the call type to master station call filters, annunciation station call filters, or 
other specific call filters.
In the Call Definition pane, create a Long and Short name for the call definition. The long name will 
show if applicable, but if there is limited space, the monitor will only show the short name. Enter a Priority 
(ranges from 0 to 255). The higher the number, the higher priority the call type will show on a master sta-
tion, event monitor, or Tek-CARE TV. For example, a code blue would be a higher priority than a routine 
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call due to the importance of the call. The Call Class will determine how the call type will be annunciated. 
A normal standard call verses a staff call will show different indicators on a master station. 
The LED Settings pane allows for customization of the rate and style of the Call LED, Peripheral LED, 
Duty Tone and Flash Rate, and a Duty Indicator. GEN3 Annunciation LED Color is used to select the 
LED color used to display the call when annunciated on G3 multi-purpose stations.
The Fixed Color Dome Lights pane is used for TC300III LI38x- and TC400 LI48x- series lights. 
The Variable Color Dome Lights pane is for TC400 P5/P5+, TC400 GEN3, and TC3000 LI484P5 lights.
The Two-Color Dome Lights pane is for TC120 LI122 or LI122BL room controllers with dome lights.
In the Audio File pane, choose the sound the masters and monitors will play to annunciate the call by 
choosing a Track and Interval speed.
In the Options pane, check Silenceable to be able to silence the call. If silenceable, a call can be muted at 
the master station using Tone Silence, and at the duty station by pressing the Reset button. 
Selecting Attended will force staff to reset the call from the point of origin within the patient's room. If 
Attended is not selected, some input types allow calls to be reset by making an audio connection to the 
room from a master. 
Force Domes will cause the lower priority calls to be annunciated as well as high priority calls on an 
unused section of a dome light (if available).
Screen Color gives the option to choose the background color used to display the call on a master station, 
monitor, or mobile app. RF Page Level will assign the escalation code (priority) for the specified call type 
to be annunciated on a pager.
Central Monitoring Code is the contact ID code that identifies the event type of the call. This code will be 
used by the central monitoring station. Select Apply. 

NOTE: Be sure to contact the central monitoring company for the default code list for ref-
erence if changes need to be made.
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Call Filters Tab
Select the appropriate Call Filters to be annunciated by various masters and other annunciation devices. To 
add a new call filter, select Add in the Call Filters pane, then create a name for the filter in the Details 
pane. Select the different call types to include within the call filter. Select Apply.

 

Fault Options Tab
To enable maintenance fault, select Edit in the Fault Settings pane and check the box to Enable Main-
tenance Fault.
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NOTE: A maintenance fault is a software-latched fault that indicates some other fault has 
occurred on the system. It can be used as a steady fault to send to maintenance staff pagers 
or email addresses. It must be cleared manually with a redetect after other faults have been 
resolved.  
 

Fault Filters Tab
A fault filter includes a list of faults that will be annunciated on various annunciation devices, and staff 
assignments once a fault appears on the system. 
The current Fault Filters included in the ConfigTool are All Faults, Maintenance, Missing, and No 
Faults. To edit any of these, select the specific filter, then select Edit in the Details pane. 

Select Add to create a new fault filter. Create a name for the fault filter.  Select All to include all faults 
within the filter or select all of the applicable faults to be included within the fault filter.
Deselect a fault to remove it from the filter. Select Apply. To delete a fault filter, select the fault, then 
Delete. For a description of each fault, select Help → Fault Table. 
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Behaviors Tab
The Behaviors tab is used to change or add hardware-specific behaviors. For example, an SF520UL can be 
a Security Device or a Check In Device. 
The Behaviors tab shows the default behaviors for all hardware. To change the hardware, choose a Hard-
ware Type and  select Edit under Hardware Type Details then select different defaults and behavior 
details. Select Apply. 

To add a new behavior to a specific hardware, select Add under Hardware Behaviors. Create a name for 
the behavior under  Hardware Behavior Details and select the appropriate behaviors for the hardware. 
To change the bed exit settings, select Edit under Hardware Settings. The Bed Exit Delay timer can be 
adjusted up to 10 seconds. If the timer is set to 0, a call will be placed immediately once the input has been 
activated. Check Bed Exit Latched to reset the call at the station then select Apply. 
To delete a hardware behavior, select a hardware behavior then select Delete. 

NOTE: Any changes made to a hardware type's behavior will be applied to all hardware util-
izing that specific behavior.

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1150 LS450 ConfigTool 2.0 Manual | 25

Behavior Page



Behavior Page

Foreign Rule Sets Tab
A foreign rule set acts as a container for the rules and hardware behaviors that it takes to characterize a for-
eign system type. Select the Foreign Rule Sets tab to create a foreign rule set. Select Add to create a name 
for the foreign rule set. Select Apply. To delete a foreign rule set, select it, then select Delete.
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Foreign Rules Tab
The foreign rules map messages that come from interfaces to either activate or deactivate call inputs of vari-
ous foreign devices.
Select the Foreign Rules tab then select Add to create a foreign rule. In the Details pane, select the appro-
priate rule set. Select Apply. To delete it, select the foreign rule, then select Delete. Test the foreign rules 
by entering the various input and output fields under Testing. Allow the testing to take place before com-
mitting the configuration.
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Stations Tab
To detect and configure a new station, select the Stations tab on the Field Devices page. 

Select a station from the list, then select  Edit in the Details pane. Create a Name for the station (usually 
the room number). 
If there is more than one side to a station (ex. IR432G3) allowing for sided calls like Side A and Side B, 
select the correct Side for the station. 
The Type of station determines the different options available to set for that specific station. 
The Behavior of the station will determine the call types the station will place. 
If desired, calls from one station may be forced to annunciate on the dome light of another station. The sta-
tion selected in the Secondary Dome Annunciation drop-down list will annunciate calls on its dome light 
from the station being edited.

 NOTE: Stations used in this way must be connected to the same module.

If the station will receive audio paging, check the Paging box in the Options pane. Check the Privacy box 
to ensure that if a station is selected from the master and audio is connected, the audio is one-way only 
from master to station.
 Check the Room Reset box to allow the station reset button to reset any calls placed in the room directly 
from the station. 
If the station will receive zone paging, select the appropriate Zones the station will be in with the Zoning 
pane.
In the Audio Settings pane, choose either Half Duplex or Full Duplex. Half duplex only allows audio in 
one direction at a time (like a radio - push to talk, release to listen). Full duplex enables simultaneous audio 
to and from the station (like a telephone - talk and listen simultaneously). If necessary, make appropriate 
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adjustments to the Speaker Volume and the Mic Gain to adjust the input volume to the station being 
edited. 
In the Outputs pane, enter the Output 1 Name and Output 2 Nameto show output controls on the master 
stations. Check the Output 3 Enabled and/or Output 4 Enabled to utilize additional outputs.
For use with Dry Contact DC1 - DC4 options on Multi-Purpose Stations: 
DC1 through DC4 are mapped to the outputs respectively. To enable, enter the Output 1 Name and Out-
put 2 Name, then check the boxes for Output 3 and Output 4.  
Output 1 provides a 5-Second On, Output 2 provides a Toggle On and Off (controls are on the master sta-
tion), Output 3 provides a local output for the duration of the call, and Output 4 provides a zones watched 
output for the duration of the call(s).
For legacy stations:
For use with the IR41xP5 Legacy stations where PM420 modules are employed. To enable, enter the Out-
put 1 Name and Output 2 Name, then check the boxes for Output 3 and Output 4.
Output 1 is momentary for 20 seconds. Output 2 is latching. Then Output 3 cycles with the call and Out-
put 4 will activate while a call is on the station.
If rounding will be used on the station, check the Rounding Enabled box and select the appropriate 
Rounding Assignments schedule for that station. Input Rounding Settings Tab on page 44 and Round-
ing Schedules Tab on page 45 on the Patients page before enabling rounding on the station. Once the 
rounding is enabled on the station(s), select the Behaviors Tab on the Behavior Page to verify the round-
ing behavior. If the station is placed in an unoccupied room, uncheck Rounding Enabled. Select Apply.
 

Points Tab
Points are the six physical connections on the rear of each room controller or station that are used in Tek-
CARE120, Tek-CARE400 P5+/GEN3, and Tek-CARE3000 Nurse Call Systems.  These are shown as points 
1-6 in the configuration. In addition to the physical points, there are also two additional points present in 
the configuration for the LI122 and PM120. Refer to IL992  TC120 Installation Manual, IL1059 TC400 P5+ 
Installation Manual, IL1119 TC400 GEN3 Installation Manual, and IL1140 TC3000 Installation Manual for 
more information.

NOTE: If using rounding on the TekCARE120 system, the station must have an SF123 or 
an SF124 configured as a room reset.

By default, all of the room controller points are assigned to a station in the ConfigTool. The physical 
address of the room controller determines which station points are assigned to. 
A point can be in three states within the ConfigTool:
 

Detectable: When points are in the Detectable state, the central is constantly polling those points, 
searching for attached stations.

Exists: If a point is marked as Existing, the point is supervised and the system assumes that a sta-
tion is connected to that point. If a station goes missing or is not detected, a fault will annunciate 
for that point.

Disabled: If a point is marked as Disabled, the system does not look for station attachment at the 
point.
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To edit points, select the Points tab on the Field Devices page selection pane. Check the Hide Disabled 
and Hide Detectable boxes to view only existing points.
Locate the correct point group that refers to the address of the specific station or room controller that the 
points are physically connected to. Either edit one point or edit multiple points at once. 
To edit only  one point at a time, select the point, then select Edit. In the Details pane, select Disabled, 
Detectable, or Exists from the Exists drop-down in the Details pane. Select the Assigned Station the point 
is assigned to, select the hardware Type, then select the correct Function. Select Apply. 
To edit a group of points, select a point, then select Edit Multiple in the Details pane. Change the applic-
able points to show as Existing, select their Type, and select a Function for each point. Select Apply. 

NOTE: Be sure to periodically run the consistency check to look for errors created by edit-
ing points.
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Transmitter Settings Tab
Use the Transmitter Settings tab options to enable wireless emergency call systems.  See IL881 Tek-
CARE500 Installation Manual, or IL1089 Tek-CARE570 Installation Manual for additional details.

 

Transmitters Tab
Transmitters and wireless system receivers and repeaters are added within the Transmitters tab. Trans-
mitters are assigned to either a person or to a location, depending on the type of transmitter used. To create 
a new transmitter, select the Transmitters tab on the Field Devices page. 

To add transmitters via a barcode and scanner, select Add Barcode in the Transmitters pane. When the 
Add Transmitter by Barcode window opens, select Echostream or TC570 in the Hardware Family 
pane, then scan the barcode. The Device # will auto-populate.
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To add transmitters manually, select Add in the Transmitters pane. In the Details pane, select the appro-
priate Transmitter Family (FAfor Frequency Agile, ES for Echostream, or TC570) from the drop-down.

NOTE: Be sure to chose the correct Transmitter Family setting, as this is a global action 
for all transmitters. 

Enter the Device #alocated on the back of the device. (The device number will be exactly four or eight 
hexadecimal digits.) Create a Name for the transmitter and select No, Yes, or Away from the In Use drop-
down menu. 
In the Hardware pane, select a hardware Model and Behavior for the transmitter and its use.
In the Supervision pane, select the Interval the transmitter will send supervision signals, and select when 
the timeout will show if the transmitter has gone missing. Select the desired Interval and Timeout values. 
In the Assignment pane, choose the appropriate Location and Patient for the device. 
In the Battery pane, the Battery Low box will be checked if there is a battery low notification from the 
device. The Battery Changed box auto populates with the date after a battery change.
Select the correct Zones that will be watching the transmitter. Supervision options are configurable in the 
Supervision pane and are dependent on system model. Supervision may also be disabled by checking the 
applicable box in the Disable Supervision pane.
When all transmitter information is populated, select Apply.
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Foreign Devices Tab
Foreign devices include security systems, fire alarms, and other non-TekTone devices that will be integ-
rated with the Tek-CARE Network. See IL970 Tek-CARE700 Installation Manual for additional details. 
To add a new foreign device, select the Foreign Devices tab on the Field Devices page, then select Add. 

The Details pane allows users to enable and manage the foreign device. Select the Enabled box, enter the 
Device ID, and enter a Name for the device. Select the device Type from the drop-down.
If a location is created on the Locations page, choose the appropriate entry from the Location drop-down 
list, along with the Location Side. 
Once an interface has been created in the Interfaces tab, it will show as an interface option. If there is not 
an interface to choose from, create a new one on the Interfaces tab within the System page. Select a Beha-
vior for the foreign device (previously created on the Behaviors page).
Select a Timeout interval, if desired. Populate the Device Info field, and the Options field with additional 
information about or options for the foreign device. 
If assignments have already been created, select a Check In. If the rounding feature will be used with the 
foreign device, select the appropriate Rounding schedule.  Choose the correct Zone that will annunciate the 
device, then select Apply. Save the configuration.
To delete a foreign device, select the device, then select Delete.
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Zones Tab
Zones are a number of stations grouped together for various reasons. Each zone is preconfigured to include 
devices associated with the corresponding module number. Preset zones may be renamed or deleted, and 
new zones can be created. 
To create a new zone, select the Zones tab on the Annunciation page, then select Add. To edit a zone, 
select it from the list in the Zones pane,  then select Edit in the Details pane. If desired, enter a new name 
for the zone. Select Apply once the zone has been created. 

To assign stations to a zone, select the zone, select the Edit button, then select the hardware to be included 
within that zone.  Use the Annunciations and Field Annunciations tabs to select the stations that will 
annunciate calls from devices in that specific zone. See the Annunciations Tab on page 35 and Field 
Annunciations Tab on page 35 for further details.
To delete a zone, select the zone from, the Zones tab, then select Delete.         
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Annunciations Tab
Once all zones are defined in the Zones tab, use the Annunciations tab to program specific annunciations 
for masters, monitors, and duty stations. Select the zones, call filters, and fault filters in the Details pane to 
build the annunciation schemes.  Annunciations can be enabled and disabled for the selected  devices as 
needed in the ConfigTool, and once created, are also selectable on master stations.

 

Field Annunciations Tab
Once all zones are defined in the Zones tab, use the Field Annunciations tab to program specific annun-
ciations for field devices. Select the zones, call filters, and fault filters in the Details pane to build the 
annunciation schemes.  Annunciations can be enabled and disabled for the selected  devices as needed in the 
ConfigTool, and once created, are also selectable on master stations.

NOTE: If a master station has any fault filter setting other than "Default (All Faults)" it will 
not have the capability to preform a Re-Detect function.
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Masters Tab
A master station displays calls on the Tek-CARE Network. To set up a master station within the Con-
figTool, select the Masters tab in the Annunciation page. 

Select Hide Unused to hide the unused masters. Choose a master and select Edit under the Details pane. 
Create a Name and choose the correct Type of detected hardware for the master. 
If the master will be working with paging, check the Paging box in the Options pane. This option allows 
the master to receive audio pages. Select Apply.
Tone Silence Enabled either allows or disallows low-priority call tone silencing from an NC415G3 or 
NC404TS master station. By default, this option is unchecked. Only check this box if the ability is desired. 
For more information on setting up the NC404TS master station, see IL1052 NC404TS Installation Manual.
Select the appropriate Call Filters (Behaviors page) and Zones Watched (Annunciation page) that will 
be annunciated by the selected master. Select Apply once all of the master stations have been created. 
Refer to Call Filters Tab on page 23 and Zones Tab on page 34 for detailed information on the call fil-
ters and zones features.
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Masters Settings Tab
The Detect Masters setting is enabled by default. Technicians should consider disabling this setting when 
adding GEN2 modules, because each GEN2 module has 10 potential masters, and those count toward the 
Tek-CARE system limit of 100 masters. Disabling the Detect Masters setting will ensure that the potential 
master slots do not count toward the limit of 100 masters.
To disable this setting, select the Masters Settings tab in the Annunciations page. Select the Edit button, 
then select the Detect Masters checkbox to disable/enable.
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Monitors Tab
The Monitors tab in the Annunciations page provides the option to add a remote monitor, or pair a mon-
itor with an NC404 master console and choose the View (screen layout). Choose the call filters that will 
annunciate on the monitor with the Annunciations tab. See Annunciations Tab on page 35 for further 
detail.

To add a new monitor, choose a monitor from the list, then select Edit. Change the name of the monitor to 
something that is easily recognizable. If this monitor is to be recognized on the Tek-CARE Network, select 
the Exists box. 
Select the Supervised box to display a fault if the monitor disconnects from the network. 
 In the Type drop-down, select either Standard, Non-Interactive, or Paired with NC404.
Standard type is interactive (ex. NC403TS). Non-Interactive type (ex. an Apple TV with the Tek-CARE TV 
app) is for viewing and display purposes only. 
Paired with the NC404 will allow the monitor to be paired with the master station and allow the NC404TS 
different viewing options. Refer to IL1052 NC404TS Installation manual for more information. If paired 
with an NC404TS, select the master from the Paired Master drop list. 
Select the Play Sounds box for the monitor to play sounds when a call is active on the Tek-CARE system. 

Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved IL1150 LS450 ConfigTool 2.0 Manual | 38

Annunciation Page



Annunciation Page

 The NC475 may serve as a primary annunciator on the system (Monitor ID 0000). However, if it will be 
unattended in an equipment room, it is required to deselect the Primary Annunciation box. If the 
aaaaPrimary Annunciator is selected for the NC475, the following warning will be displayed when the 
configuration commits to the system: 

 
To create an access code called the LCD Maintenance Menu PIN for the LCD Menu on the  NC475, enter 
the LCD Maintenance Menu PIN.
If paired with an NC404, choose either List Only (same functionality as an event monitor), List and Icon, 
or List and Map in the Views drop-down. The List and Icon view will produce a visual layout that will be 
created within the LS450 ConfigTool.
With the Zones Tab on page 34 (Annunciation page) and Call Filters Tab on page 23 (Behavior page), 
select the applicable zones and calls that are to be annunciated on the monitor. Select Apply.
 

TVs Tab
A Tek-CARE TV is a non-interactive app on an Apple TV that displays calls from the Tek-CARE system. 
To add a Tek-CARE TV in the ConfigTool, select the TVs tab on the Annunciations page.

The license quantity will start with ID 0. 
The TVs pane shows the ID (0-254) and Name (TV0-TV254) for each of the Apple TVs.
To edit attributes of a TV, select it from the list, then select Edit in the Details pane. Enter a new Name for 
the TV if desired and check the Exists box. Uncheck the Display Patient Names box if the facility does 
not want patient names displayed on the TV due to privacy reasons. Select Apply to accept the changes. 
Repeat this process for all TVs installed in the facility, then save the configuration.
 

39|IL1150 LS450 ConfigTool 2.0 Manual Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved



Locations Page

 

Locations Tab
Locations are created to represent the actual locations within the facility. In a default configuration, loc-
ations are already created to match the potential station names.
Select the Locations tab in the Locations page, then select Add to create a new location. To edit a loc-
ation, select it from the list in the Locations pane, then select Edit. 

In the Details pane, enter a Name for the location. If there is a proximity map already uploaded to the Con-
figTool, select the applicable map from the Proximity Maps drop-down. 
To load a map, select Add in the Proximity Maps pane, enter a name in the Details pane, then choose the 
Load From File button. Acceptable file formats for proximity maps are .bmp, .gif, .jpeg, and .png.
Select the desired proximity map, plot the various points on the map, then select Apply. Once the con-
figuration is saved and committed, the proximity map will place location icons into the map  and display 
those locations on  any monitor, if List and Map is selected on the Monitors page. Refer to the Monitors 
Tab on page 38 for further detail.
To delete a location, select a location from the list, then select Delete.
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Equipment Tab
Add asset trackers for foreign devices with the Equipment tab in the Locations page. 

To add equipment, select Add in the Equipment pane, populate the Description field in the Details pane 
and select Apply. The Equipment Badges pane is used for older legacy systems and is no longer applicable.
 
To delete equipment, select the equipment from the list, then select Delete.
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Patients Tab

To add a patient, select Add in the Patients pane under the Patients tab. Enter the patient's name. Upload a 
picture of the patient by selecting Add in the Images pane. Image files such as .bmp, .gif, .jpg, and .png 
may be uploaded to the ConfigTool. Select Apply to save the entry.
In the Locations pane, select a Default Location and Default Side in the respective drop-downs if applic-
able.
By default, Patient Information only provides for the name for the patient. To add more fields, select Add 
in the Patient Fields pane to create additional information about the patient. Examples of additional patient 
fields include key notes about the patient such as allergies or emergency contact information. If more than 
one Patient Field is created, green arrows to the right of the pane will appear. To change the patient field 
sequence, select a patient field from the list, then use the up and down arrows to move the patient field up 
or down in the list.
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Check In Tab
A check in requires the patient or resident within the facility to check in at certain times. Check in windows 
are created, then stations, transmitters, or switches are assigned in that window.
If the patient or resident does not check in as expected, an inactivity call will be produced on the Tek-
CARE Network event monitors, masters,  pagers, and mobile apps to alert facility staff that the check in was 
not completed. 
 Stations are assigned check in times in the Check In tab. Transmitters will be assigned to the appropriate 
check in window through the Transmitters tab on the Field Devices page. See Transmitters Tab on page 
31 for further detail.
To create a check in time, select the Check In tab in the Patients page selection pane, then select Add. 
Enter the Time Interval in the Details pane for the required time frame and days of the check in. 

Select the stations to be used for assignments in the Check In Assignments pane, if applicable. 
If the patient or resident will be away on vacation, select Edit in the Vacation pane and enter the time 
away for the patient or resident to temporarily remove that device from the requirement until the patient 
returns to the facility. Select Apply. 
To delete a check in, select the entry from the Check In Time pane, then select Delete.

NOTE: For daily editing or administrative work, the ConfigToolLive is generally the most 
efficient tool, as it allows many  edits to be done in real time.
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Rounding Settings Tab
The rounding feature ensures staff members will attend to their associated patients in a timely manner. 
Reports run by the facility will show the rounding times of each assigned staff member. Rounding Settings 
are global.

 NOTE: Assigning a point as a room reset for the SF123 station is required for the rounding 
feature to be used on Tek-CARE120 systems.

 
Select Enabled to enable the rounding feature. To disable rounding with a long press, select the Disable 
Rounding With Long Press box; this feature allows for disabling rounding with a long press when the 
room is empty, however, legitimate calls from the room will place it back into the rounding cycle.
Select the Reset Button box  if room station reset buttons will be used to trigger a rounding event. Hold 
down that same button for approximately three seconds to disable the rounding event.  
Select the L1, L2, or L3 boxes if those buttons (found on the SF124) will be used to trigger a rounding 
event. Select Apply when finished.
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Rounding Schedules Tab
Use the Rounding Schedules tab on the Patients page to create a schedule for the rounding feature.

 Select Add in the Rounding Schedules pane. In the Details pane, enter a Start Time and End Time and 
choose the week days for the schedule. 
The default Rounding Period is set to one hour. If applicable, change this setting to the facility's pref-
erence. 
Enter the number of minutes before the end of the rounding period to send a rounding reminder message to  
staff in the Reminder (minutes) field. The default Reminder (minutes) to send a reminder to staff is 5 
minutes. The reminder can be edited if desired. Once complete, select Apply. Then, select the Stations tab 
on the Field Devices page to enable rounding and select the appropriate schedule for that station.
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Patient Settings Tab

 
To change the Occupant Term displayed in the page selection pane, select Add in Patient Settings. Enter 
a different occupant term such as resident, guest, etc., then select Add.

The Global HL7 Settings enable the Tek-CARE system to receive patient information from a facility's 
ADT system via HL7 messages. Setting a bed override character will override the bed field in all HL7 mes-
sages.  This is useful if there is only one bed per room and the ADT system is filling in the bed field with a 
copy of the room number. Select Edit in the HL7 Settings pane, then enter a character to override the bed 
field in the messages. This is set up as a foreign interface.
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The staff devices page allows for management of staff device notifications such as pagers, phones, and 
mobile apps.
 

Pagers Tab
NOTE: Paging must be enabled for email capabilities.

To add a pager, select the Pagers tab in the Staff Devices page and select Add. Enter a CAP Code under 
the Details pane and select Apply. 
 
Use the Staff Device Settings tab to apply additional  settings for these devices. See Staff Device Settings 
Tab on page 51 for further details.
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Phones Tab
Select the Phones tab in in the Staff Devices page and select either Add or Add Multiple. Select Edit 
under the Details pane to enter the extension available for use on the facility PBX. Select Apply to finish.
Use the Staff Device Settings tab to apply additional  settings for these devices. See Staff Device Settings 
Tab on page 51 for further details.
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Email Tab
NOTE: Paging must be enabled for email capabilities.

Facility faculty members and support personnel can receive reports and notifications via email. The facility 
must have an in-network email server for this feature to work. 
To create an email address for the facility staff, select the Emails tab on the Staff Devices page. Select 
Add to add an email address. If the email server does not require a subject, select No Subject in the 
Details pane. Select Apply when finished. 
 To delete an email address, select the email address, then select Delete.
Use the Staff Device Settings tab to apply additional  email settings. See Staff Device Settings Tab on 
page 51 for further details.
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Mobile Apps Tab
The Mobile Apps tab enables  facilities to distribute nurse call alerts and information to staff quickly and 
easily on their mobile device. Paging must be enabled for mobile apps functionality.
Refer to IL1010 Mobile Apps Installation manual for more information. 
Select the Mobile Apps tab from the Staff Devices. The list in the Mobile Apps pane shows the ID (0-
254) and default name (App0-App254) for each of the licensed mobile apps.
To change the default name for an app, select the app to rename, then select Edit in the Details pane. Enter 
a new name for the app. Choose whether the mobile app will be Online and be receiving notifications or 
Allow Offline to not receive notifications (if the device is locked to the server), then select Apply. Repeat 
as needed for all apps to be renamed. 
Use the Staff Device Settings Tab on page 51 to apply additional  settings for these devices.
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Staff Device Settings Tab
Use the Staff Device Settings tab to customize settings for pagers, phones, email, and mobile apps.
To change the phone settings, select Edit under the Phone Settings pane.
Select an option in the Phone Out Mode drop-down to select the method used to send messages to phones. 
The Dial Prefix is the code that is dialed to connect to the nurse call system. Use a comma to generate a 
pause in the dialing sequence. 
The Access Code is an optional numeric password that protects against unwanted telephone access to the 
nurse call system. 
Select E.161 Layout if the phone being used has that type of keyboard. Uncheck this option if the phones 
do not have Q on the 7 key and Z on the 9 key.
Select the Enable Name Dialing box to enable phones to dial stations by name. Leaving the Enable Name 
Dialing box unchecked will allow address-based dialing without requiring # prefixes.
If  Manual is selected under the Audio Acknowledgment drop-down, pressing 9 on the phone during an 
audio connection to a station will clear any call that would be cleared by an audio connection from a mas-
ter. If Auto is selected under the Audio Acknowledgment drop-down, the calls will be cleared when the 
audio connection is terminated.
The PBX IP Address is the IP Address of the PBX the NC475 Tek-CARE Central Equipment will connect 
to.
The Ring Count is the number of times a phone will be ringed per notification. The default number is 10. 
Select the up or down arrows to change the ring count.
In the Mobile Apps Settings pane, select Edit, then select the Mobile App Timeout box to automatically 
consider disconnected mobile apps as offline 1 week after being disconnected from the system (this stops 
push notifications until reconnected to the system).
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To edit email settings, select Edit in the Email Settings pane. Ensure that Enabled is selected in the Mode 
drop-down so that email communication is sent. 
Enter the SMTP Host and SMTP Port. Enter an email address to be displayed in the From Address field.
Select the Messaging Enabled box to allow email addresses to be used with direct messaging features. 
Select the Reports Enabled box to enable the report email component, and the Send Missed Reports box 
to send reports missed during times when the email system is down.
If the report email component is not running, check the Send Missed Reports box to send out those reports 
via email.
Select Apply once the changes have been made. 
To delete an email address, select the email address, then select Delete.
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To edit pager settings, select Edit in the RF Pager Settings pane. Select Enabled in the General Settings 
pane to enable the paging functionality. Select Base Supervision to create a fault if the paging base is dis-
connected.
In the Protocol Settings pane, select the protocol for the Base Type (COMP2, Scope, or TAP).
Enter the CAP Base (only applicable to the Scope or TAP protocol).
Select the RF Baud rate from the drop-down if using the Scope Protocol under Base Type. This rate is 
used to send messages to pagers. 
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Select the Esc Char box to send an escalation character.
In the Automatic Paging Settings pane, select the Auto Page box if automatic paging assignments have 
been created for staff. If necessary, change the default seconds to delay a page between Escalation levels. 
Regenerate does not apply to apps, because the event remains on screen until resolved.
In the Other Settings pane, select the Global On box if global paging should be optimized, then select the 
Global CAP code which is programmed into all of the pagers. Use the Pager Type drop-down to select the 
pager type. The Echo To Phone Out box is a legacy setting; when selected, RF pages will also be sent to 
the legacy NC464 CCM.
In the Message Fields pane, select the fields to show in a message on a pager:
Select the Notification Type box to show either Call, Reset, Fault, or Clear based on the call event.
Select the Event Type box to show the call or fault type in the message. 
Select the Device box to include either the device name or ID in the message.
Select the Patients box to show the patient's name in the message. 
Select the Location and Detected Location boxes to show the location and the last detected location of the 
device in the message.
Select the Start Time box to show the start time in the message.

54|IL1150 LS450 ConfigTool 2.0 Manual Copyright © TekTone Sound and Signal Mfg., Inc. All Rights Reserved



Staff Page

The staff page allows for management of staff assignments, notifications, and shifts. Staff can also be man-
aged by group and type.
 

Staff Tab
To add facility staff, select the Staff tab on the Staff page, then select Add.
Enter the staff member's Name, and select their Type from the drop-down. Select the Active box to enable 
the staff member. Select the staff member's Home Zones, Email Address, Mobile Apps, Phone, and/or 
Pager to be used by the staff member, then select Apply.
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Staff Groups Tab
A staff group is a group of facility staff members that have similar characteristics—for example, the staff 
members work the same shift, cover the same zone, are all nurses, or are all aides. Staff groups are mostly 
used for assignments and/or messaging options.  A staff member may be added to multiple staff groups. 

To create a staff group, select Add to unlock the Staff Groups pane for editing. Enter a Name for the staff 
group, then select the staff members to be assigned to the group from the list provided. Select Apply to 
accept the changes. 
 

Staff Types Tab
To add or edit a Staff Type, either select a staff type, then select Add in the Staff Types pane or Edit in 
the Details pane. Once the details are complete, select Apply.
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Assignments Tab
Assignments define which calls are sent to each staff member or staff group. To add an assignment, select 
the Assignments tab on the Staff page.

Select Add to unlock the Details pane for editing. Select the type of staff to be assigned from the Staff 
Type drop-down menu. Use Staff to assign an individual staff member, Staff Group to assign a group of 
staff, or All Staff to create an assignment for all active staff members. 
Next, use the Name drop-down menu to select the staff member or staff group you wish to create an assign-
ment for. Note that the Name menu is not available if All Staff is selected in the Type menu. 
Use the Device pane to choose what calls annunciate on the mobile apps that were chosen in the Details 
pane.  The Type drop-down menu has five choices: Station, Transmitter, Zone, Foreign, or All Devices. 
Stations and transmitters allow a particular device to be assigned to a staff member. The most common 
choice for mobile app assignments will be Zone or All Devices. 
Select the Name of the station, transmitter, foreign device, or zone you wish to assign. Note that if All 
Devices is selected, the Name menu is not available. 
Use the Call Filter menu to choose the call priority annunciated by the assignment, then select which 
faults, if any, should be annunciated using the Fault Filter menu. 
The Page Resets selection does not affect the mobile app annunciation, but is useful when using pagers and 
phones to let other staff members know the call has been reset.
Use the Settings pane to choose the escalation Level of the assignment (primary, secondary, tertiary, etc.). 
The Shift menu allows a custom shift to be selected. If custom shifts are not used, select Always. Select 
Apply. 
To delete an assignment, select the assignment, then select Delete.
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Shifts Tab
Select the Shifts tab to create and manage custom shifts. Select Add, then in the Shift Details pane enter 
the shift Name, choose the shift Week Days, enter the Start Time and End Time, then select Apply. The 
start and end times will be specified in 24-hour format. 

 

Scheduled Messages Tab
Scheduled messages may be sent to staff with pagers and mobile devices. Users can change the settings, 
timing, and recipients of the scheduled messages.
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To create a new scheduled message, select the Scheduled Messages tab in the Staff page and select Add. 
Under the Details pane, create the Message and choose the escalation level for the RF Page Level. High 
and Urgent are the highest priority, whereas low and medium are lower priority messages. 
Under the Schedule pane, choose a time and the week days the scheduled messages should be sent out. 
Under the  Staff pane, select the Type drop-down to send the scheduled messages to all staff, a staff group, 
or a specific staff member. Select Apply to complete entry of the scheduled message(s). 
To delete a scheduled message, select the scheduled message, then select Delete.
 

Text Messages Tab
To add or edit pre-programmed text messages for staff, select the Text Messages tab in the Staff page. 
Select the desired text message and click Add in the Text Messages pane or Edit in the Details pane. 
Select the applicable Staff Type for the text message, then select Apply. 
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Create scheduled reports that are automatically sent to selected email addresses. This option requires LS453 
Email Output Software.
 

Reports Tab 
To create a new report, select Reports in the page selection pane, then select Add. 

Under the Details pane select a Report Type which allows the facility to get a range of reports from hourly 
to weekly. Populate the email Subject for the report. The facility can choose report output as either HTML 
that is included with the email, or a CSV file. Choose the Recipient(s) who will be receiving the report.
If Daily Shift is chosen as the Report Type in the Email Options pane, the Shift drop-down under the Fil-
tering Options pane becomes available and will allow the option to choose a shift for the report. Entering a 
Response Time results in reports only including events where the response time exceeds the value entered. 
Use the Call Filter and Fault Filter drop-downs to select the calls and faults included within the report.
Select the Filter Zones box to choose which zones will be included within the report. If this option is not 
selected, the report will generate for all zones.
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In the Summary Options pane, select the applicable summary to include in the report for the facility. 
In the Detail Options pane, choose to Include Details, Include Zones, and/or Include Patients to specify 
the level of detail included within the reports. 
Choose a value for Overlap Gap to overlap a time gap in between reports.
To delete a report, select the report from the list, then select Delete.
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Central Monitoring 

Central Monitoring Tab
When central monitoring is enabled, the ConfigTool sends events via a serial connection to the NC502 PC-
Alarm Panel or the NC503 Central Monitoring Modem. Both devices dial the central monitoring facility's 
telephone number and transmit the events to the  central monitoring facility.
When the central monitoring app sees an alarm, the software tries each telephone number in order and uses 
the first one that connects. If that telephone number stops working, it continues through the list until it finds 
another working number, retrying once per minute until it connects.
Select the Central Monitoring tab on the Central Monitoring page.

To select a schedule, select Edit under Schedule to choose a shift for the central monitoring. Select Apply. 
Select Add in the Phone Numbers pane. Type the central monitoring facility’s telephone number, then 
select Apply. Repeat these steps to add another phone number to the list. 

NOTE: Be sure that the central monitoring station phone numbers are entered exactly as 
they were provided by the central monitoring company.

To change the phone number sequence, select a phone number from the list and then select the up and 
down arrows at the right to move the phone number up or down in the list.
Select Apply to accept the changes.

NOTE: To utilize the Schedule pane, ensure that shifts are first created in the Shifts tab on 
the Staff page. To utilize the Locations pane, ensure that locations are first created in the 
Locations tab on the Locations page.
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Central Monitoring

NOTE: If a location is not checked in the Locations list, events from that location will not 
be transmitted to the central monitoring facility. Select Edit under Locations, then select the 
locations for the central monitoring facility. Select Apply.

 

Central Monitoring Settings Tab
Select the Central Monitoring Settings tab on the Central Monitoring page.
Select  Edit, then select either Disabled, NC502, or NC503 from the Mode dropdown.

Enter the facility’s Account code and note here: ______________.
Check Send Mobile Device Events if the facility wants events from mobile devices to be a part of central 
monitoring. Check Send System Faults to send faults from various sources, such as repeaters, modules, 
etc. Choose 9600 for proper Baud rate between the computer and the alarm panel. The 9600 baud rate is 
for both NC502 and NC503. 
Configure dialing options as needed to Disable Call Waiting or to use a prefix to Dial an Outside Line, or 
to Dial “1” for 10-digit numbers. Select  Apply, then save the configuration.
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Software Updates

 Before updating system software, select File→Load Configuration From System then select Save. 
 l For the NC474 Tek-BRIDGE Server, 7336 is the latest version of the LS450 ConfigTool. Further 

updates will require an upgrade to the NC475 Tek-CARE Central Equipment.
 o If the facility is on software version 7253 or older,  contact support for additional steps. 

Contact our Technical Support Department by email at tektsupt@tektone.com or by phone at 
828.524.9967. Choose Option 3.

 l For the NC475 Tek-CARE Central Equipment, visit https://www.tektone.com/resources/ and 
select the Tek-CARE Software Updates pane to find the latest updated version of the LS450 Con-
figTool. Install the LS450_setup_xxxx.exe on the programming laptop connected to the Tek-
CARE Network.
IMPORTANT: System settings return to the default configuration after being updated. In order to 
not lose the programmed configuration, be sure to save the configuration before and after being 
updated.

Double-click the LS450 ConfigTool on the programming laptop connected to the Tek-CARE Network. In 
the splash screen, select the IP address of the network interface that is connected to the Tek-
CARE Network. These can be done in no particular order. Under Utilities, select the following options:

 o NC475 Update Server.
 o Upgrade GEN2 Modules (NC120/NC160/NC455CE/NC356CE).

To reload the saved configuration, select File→Open Configuration and choose the saved configuration.
Test the system before turning it over to the facility. 
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Tek-CARE300II Database Import

There are two ways to incorporate Tek-CARE300II stations into a Tek-CARE system:
 1.  Replace the Tek-CARE300II system with one or more NC356CE and import the stations as full 

Tek-CARE stations.
 2.  Leave the Tek-CARE300II system running, connect it to the Tek-CARE system as a foreign inter-

face, and import the stations as foreign devices.
With either approach, the LS450 ConfigTool provides an easy way to import station names and other set-
tings from the Tek-CARE300II database.
 

Obtaining a stations.db File
Perform this procedure before importing either the NC356CE or foreign devices. Repeat this step for each 
Tek-CARE300II system that is being replaced:

 1.  While the Tek-CARE300II is running, download the stations database to a stations.db file. You may 
choose your own file names, using a .db extension, if multiple Tek-CARE300IIs are being replaced. 
(Instructions for creating the stations.db file are in the System Configuration and Programming Sta-
tion Database Functions section of the IL715 Tek-CARE300II manual.)

 2.  Copy the stations.db file to the computer running the LS450 ConfigTool.
 

Importing to a NC356CE 
When Tek-CARE400  NC356CE TC300II/III head-end modules will be used to replace the central equip-
ment of a Tek-CARE300II system, this procedure can be used to import the Tek-CARE300II stations data-
base into the Tek-CARE system. This optional step may make it easier to program station names and 
settings on the Tek-CARE system.

Note: These instructions assume that the modules have been added to the system, and that all 
modules and the LS450 ConfigTool have been updated to the latest revision.

 1.  Power off all Tek-CARE300II central equipment.
 2.  Power off all Tek-CARE modules.
 3.  Disconnect the station cables from the NC351/A-series Central Equipment and connect them to 

NC356CE modules in the NC450 Central Equipment.
 4.  Power on all Tek-CARE modules.
 5.  Open the ConfigTool and select Load Configuration From System.
 6.  Repeat this step for each stations.db file downloaded:

 a.  Select Tools→NC300II Database Import to NC356CE.
 b.  When the file browser requests the location of the stations.db file, locate the file and select 

OK.
 c.  The Import Port Identification dialog will be shown with a row for each populated port in 

the stations.db database. Each port will be identified by a few of the room numbers from that 
port in the Tek-CARE300II system. Select the location of each corresponding port (by module 
number and port number) in the Tek-CARE system.  Carefully identify the new locations, then 
select OK.

 d.  Next, the Import Options dialog will ask which station settings to include in the import. 
Select which settings to import, then select OK.
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 7.  Select File→Save Configuration As to save a copy of the current system configuration.
 8.  Select File→Commit Configuration To System to upload the configuration to the Tek-CARE sys-

tem. After the upload is complete, the system will reboot.
 
 

Importing as Foreign Devices
Tek-CARE NC300II Stations can be imported as Foreign Devices by selecting Tools→NC300II Database 
Import as Foreign Devices. A valid NC300II database file is required for import. Repeat for each sta-
tions.db file to be imported.
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There are two operations that can be performed from a master station or monitor to clear faults in the sys-
tem. Most faults indicate that either hardware or software is not communicating as expected. There are two 
ways to deal with faults:

 1.  Repair the situation - fix the hardware that is in fault, or fix or restart the software component that is 
in fault.

 2.  Tell the system that the situation is acceptable; the hardware or software is no longer expected to be 
present in the system. Go to the station giving the fault and select Redetect.

Name (short Name) Device Description
Audio Mode Incompatible
(AudMode)

 The station is incompatible with the audio mode con-
figured on the NC455CE, or the NC455CE is unable 
to enter the configured audio mode due to an incom-
patible audio board.

Audio System Fault (Audio 
Sys)

Module Number The audio system on this module is not functioning 
properly. Audio connections to devices on this mod-
ule will not work.

Auxiliary Check In Fault 
(AuxChkIn)

Station Name An auxiliary check in peripheral is not com-
municating with the system.

Auxiliary Input 1 Fault (Aux1) Station Name An isolated peripheral addressed 1 previously detec-
ted on the system is not communicating with its sta-
tion.

Auxiliary Input 2 Fault (Aux2) Station Name An isolated peripheral addressed 2 previously detec-
ted on the system is not communicating with its sta-
tion.

Auxiliary Input 3 Fault (Aux3) Station Name An isolated peripheral addressed 3 previously detec-
ted on the system is not communicating with its sta-
tion.

Badge Battery Low (BadgBatt) Badge Number A low battery has been detected on a badge.
Bath Fault (Bath) Station Name A bath peripheral previously detected on the system 

is not communicating with its station.
Battery Backup Active (Bat-
tery)

Module Number The modules have lost AC power and are running on 
battery power.

Battery Low (BattLow) Transmitter ID A low battery has been detected on a transmitter.
Battery Missing (BattMiss) Transmitter ID The primary battery for this device is missing or has 

not been removed.
CM Alarm Panel Fault 
(AlrmPanl)

  The central monitoring software component can't a 
communicate with the alarm panel.

CM Communication Fault 
(CMComm)

  The central monitoring software component is com-
municating with the alarm panel, but the alarm panel 
is giving an error because it can't successfully dial 
out. 

Call Cord A Input Fault 
(CrdAInpt)

Station Name A call cord peripheral is not communicating with the 
system.

Call Cord B Input Fault 
(CrdBInpt)

Station Name A call cord peripheral is not communicating with the 
system.

Central 12V Failure (CE 12V) Module Number A 12V power regulator internal to the module is not 
working properly.
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Central Monitoring Fault 
(CntrlMon)

  The central monitoring software component is not a 
running or is not communicating with the rest of the 
software.

Cloud License Error (LicError)   The cloud license for some enabled service is unable 
to be loaded due to some networking error.

Cloud License Info (LicInfo)   The cloud license for some enabled service is unable 
to be located with the provided System ID, Cloud 
Access Token, and NC475 Tek-CARE MAC address.

Cloud License Invalid 
(License)

  The cloud license for some enabled service is not 
valid or has expired.

Cloud License Warning 
(LicWarn)

  The cloud license for some enabled service is expir-
ing in 15 days or less.

Code Conflict Fault 
(CodeCnfl)

Station Name Both an SF441 and an SF441-1 are connected to a 
single station. Only one of the two code peripherals 
can be connected.

Code Detection Fault 
(CodeDet)

Station Name An SF441 is currently detected where an SF441-1 
was previously detected. If no peripherals were 
swapped out, this may indicate a problem with peri-
pheral wiring.

Code Fault (Code) Station Name A code peripheral previously detected on the system 
is not communicating with its station.

Communication Fault (Comm)   A communication fault is shown on a master that 
can't communicate with its module.

Configuration Conflict (Con-
fig)

Module Number  A module has a different configuration loaded than 
the rest of the system.

Data Error (DataErr)   Unexpected data has been received from or about this 
device. The device may not be functioning properly, 
or it might not be communicating correctly with the 
Tek-CARE system.

Demo License Expired 
(DemoExpr)

  The demo license for this system has expired.

Demo Timeout Warning
(DemoWarn)

  The demo license for this system will expire soon.

Device Error (DevError)   The device is not functioning properly.
Dirty Sensor (Dirty)   The sensor needs to be cleaned. 
Dry Contact Output Fault 
(DryOut)

   An SF126DC dry contact output is not aaaaaaaaaa 
communicating with the system.

Duty LED Fault (DutyLED) Station Name A duty LED peripheral is not communicating with the 
system.

Duty Tone Fault (DutyTone) Station Name A duty tone peripheral is not communicating with the 
system.

EchoStream Fault (EchoStrm)   The Inovonics ES (EchoStream) software component 
is not running or is not communicating with the rest 
of the software.

EchoStream Messaging
(EchoMsg)

  EchoStream directed messaging mode messages  
detected on a system configured for broadcast mode.

EchoStream Receiver 
(EchoRcvr)

  The Inovonics ES Network Coordinator is not prop-
erly connected or is not communicating.

Email Queue Overflow 
(EmailOvr)

  Email output has overflowed internal buffers.

Emailer Fault (Emailer)    The email output software component is not running 
or is not communicating with the rest of the software.
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Emergency Fault (Emerg) Station Name An emergency peripheral previously detected on the 
system is not communicating with its station.

Emergency2 Fault (Emerg2) Station Name An emergency2 peripheral previously detected on the 
system is not communicating with its station.

Event Writer Fault (EvtWritr)   The event writer (reporting database) software com-
ponent is not running or is not communicating with 
the rest of the software.

External API Fault (ExtAPI)   The API interface is not running or is not com-
municating with the rest of the software.

External Battery Backup
(ExtBatt)

Module Number The PK356 is running on backup battery.

External Fan (ExtFan) Module Number The PK356 fan is not operating properly.
External Power Failure 
(ExtPower)

Module Number The PK356 is not supplying power to the NC356CE.

Fan Speed (FanSpeed) Module Number Cooling fan is running out of expected speed range.
Fan Stalled (FanStall) Module Number Cooling fan has stalled.
Firmware Version (Version) Module Number A module is running a different version of firmware 

than the rest of the system.
Foreign Interface Fault 
(FrgnIf)

  A foreign protocol provider is not running or is not 
communicating with the rest of the software.

HL7 Fault (HL7)   The HL7 software component is not running or is not 
communicating with the rest of the software.

Inovonics Fault (Inovncs)   The Inovonics FA software component is not running 
or is not communicating with the rest of the software.

Inovonics Receiver (InoRcvr)   The Inovonics FA receiver is not properly connected 
or is not communicating.

Integration Server Fault 
(IntgrSrv)

  The foreign system interface is not running or is not 
communicating with the rest of the software. 

Invalid Station Address 
(InvAddr)

Module Number A station has been detected with an address set out of 
range.

Lamp Fault (Lamp) Station Name A dome light previously detected on the system is not 
communicating with its station.

Lamp Fault Aux (LampAux) Station Name An IR300 series station is unable to fully identify 
itself due to a lamp fault during startup. This station 
will not function until the lamp fault is resolved.

Maintenance (Maint)   A maintenance fault is a software-latched fault that 
indicates some other (possibly transient) fault has 
occurred on the system. It can be used as a steady 
fault to send to maintenance staff pagers or email 
addresses. It must be cleared manually with a redetect 
after other faults have been resolved.

Master Console Fault 
(MastrCon)

Station Name A master has an internal communication problem 
between its circuit boards.

Master Fault (Master) Station Name A master previously detected on the system is not 
communicating with its module.

Master Network Fault 
(MastrNet)

  A master previously detected on the system is not 
communicating with the server.

Master Version (MastVer) Station Name  A master has connected to the system and failed to 
automatically update its software from the module.

Media Gateway Fault aaa
(MediaGW)

  The media gateway software component is not run-
ning or is not communicating with the rest of the soft-
ware.
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Missing (Missing) Transmitter ID A transmitter has been marked as missing because no 
supervision signal has been received within the 
timeout period.

Module Unsupported 
(Unsuprtd)

Module Number This module type is unsupported with the current ver-
sion of software.

Monitor Fault (Monitor) Monitor Name A monitor client that was previously connected to the 
system is no longer connected.

NC475 LCD (NC475LCD)   There is a problem communicating with the LCD on 
the NC475.

Network Fault (Network) Module Number A module previously detected on the system can no 
longer be seen communicating on the network. This 
can be caused if a module has been turned off, 
removed, or there is a problem with the network con-
nection between modules.

Orphan Call (Orphan) Station Name An active call at this station is not assigned to annun-
ciate at any online master. The call will be annun-
ciated at all masters until condition clears.

Orphan System (OrphSys)   An active fault on this module is not assigned to 
annunciate at any online master. The fault will be 
annunciated at all masters until the condition clears.

Pager Module Fault 
(PageMod)

  A pager module previously detected on the system 
can no longer be seen communicating on the network.

Pager Module Overflow (Pag 
Over)

  Paging output has overflowed internal buffers.

Pager Queue Overflow 
(PagQOver)

  Paging output has overflowed internal buffers.

Peripheral Data Fault (Periph) Station Name An error was detected on the peripheral bus of the sta-
tion.

Peripheral Power Fault 
(PeriphPw)

Station Name There is an issue related to the power a station is aa 
trying to supply to its peripherals.

Phone Out Fault (PhoneOut)   The phone output (to CommTech CCM) software 
component is not running or is not communicating 
with the rest of the software.

Phone Queue Overflow
(PhoneOvr)

  The phone output (to CommTech CCM) software 
component is not running or is not communicating 
with the rest of the software.

Port Data Mode (DataMode)   Stations or Masters are marked as existing without 
the port set to communicate with that device type.

Port Polling (PortPoll) Module Number A PM455 has an internal fault related to station 
polling. Restart the module to resolve the situation.

Port Power Overload (Power-
Ovr)

Module Number A station port was pulling too much current and has 
been shut off by the software.

Power  (Power)   The device has a problem with its power supply 
(device may be running on backup power).

Psych Key Fault (PsychKey) Station Name A psych station key-switch has become disconnected 
from the station.

Push Notification Fault 
(PushNtfy)

  The mobile app push notification component is not 
running or is not communicating with the rest of the 
software.

RF Paging Base Fault 
(RFBase)

  The RF pager base is not properly connected or is not 
communicating.

RF Paging Fault (RFPaging)   The RF pager software component is not running or 
is not communicating with the rest of the software.
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RTC Time Invalid (RTCTime)   The real time clock on the NC475 is incorrect. This 
clock must be correct if any cloud features are 
enabled. The clock must be set in the setup menu on 
the NC475.

Report Emailer Fault 
(REmailer)

  The report emailer software component is not running 
or is not communicating with the rest of the software.

Reset Button Fault (ResetBtn) Station Name A reset button peripheral is not communicating with 
the system.

SMTP Fault (SMTP)   The email output software component is not running 
or is not communicating with the rest of the software.

SMTP Send Error (SMTPErr)   The email output software component detected some 
error while trying to send an email to the configured 
email server.

Secondary Battery Low 
(SecBatt)

Transmitter ID The backup battery for this device has gone low. It is 
likely that this device will be unrecoverable.

Server Fault (Server)   Tek-BRIDGE software previously detected on the a 
system can no longer be seen communicating on the 
network. The software may simply not be running on 
the Tek-BRIDGE machine or the machine may have 
become disconnected from the network, turned off or 
damaged. 

Speaker Fault (Speaker) Station Name A speaker peripheral is not communicating with the 
system.

Staff Peripheral Fault (Staff) Station Name A presence peripheral previously detected on the sys-
tem is not communicating with its station.

Station Data Fault (StaData) Station Name A station is not able to send clear data back to its 
module, possibly because two stations are set at the 
same address talking over each other.

Station Fault (Station) Station Name A station previously detected on the system is not 
communicating with its module.

Station Missing Polls 
(StaPolls)

Station Name A station is communicating with the central, but the 
communication is intermittent.

Station Power Fault 
(StaPower)

Station Name A station is connected and communicating but it is 
not receiving an optimal power supply.

Station Type Changed 
(StTypChg)

Station Name A station has been detected of a hardware type dif-
ferent from the previously detected at this address.

Station Type Invalid 
(StTypInv)

Station Name A station is reporting an invalid hardware type. This 
could be due to a failure on the station, or because 
this version of the software is too old to include a 
new station type.

Stations Updating (StUpdate)   One or more stations on this module are updating 
their firmware. Please do not interrupt.

Tamper (Tamper) Transmitter ID A tamper signal has been sent from a transmitter.
TC570 Data (TC570Dat)   Invalid data was detected in the communication with 

the TC570 receiver.
TC570 Fault (TC570)   The TC570 software component is not running or is 

not communicating with the rest of the software.
TC570 Receiver (TC570Rcv)   The TC570 receiver is not properly connected or is 

not communicating.
TC570 Receiver Version 
(TC570Ver)

  The TC570 receiver version is not supported.

Text Message Overflow a
(TxMsgOvr)

  The text messaging system has overflowed internal 
buffers.
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Unstable Power (UnstblPw) Module Number Central supply power is fluctuating on and off. Either 
AC power is fluctuating, or there is a problem with 
the DC power supply.

Unsupported Peripheral 
(UnPeriph)

Station Name A point on a P5+ station is attached to a peripheral 
not supported by that station.

Unsupported Remote 
(Remote)

Station Name A point on a P5+ station has been reassigned to a 
non-P5+ station which is not supported.

Versus Fault (Versus)   The Versus software component is not running or is 
not communicating with the rest of the software.

Weak Signal (Signal)   Messages to or from the device have a weak signal 
strength.
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